
PDF-tiedostot ja esteettömyys 
1 Johdanto 

PDF-tiedostoa käytetään paljon verkossa, koska se säilyttää sisällön ulkoasun samana kaikissa 
käyttöjärjestelmissä sekä tulostettaessa. Toistaiseksi pelkkä PDF-muoto ei kuitenkaan ole 
riittävä, koska esimerkiksi ruudunlukijaa käyttävälle PDF-tiedosto voi olla lähes saavuttamaton. 
Esteettömin toimintatapa on tarjota sekä PDF- että HTML-tiedosto. 
 
Esteettömyyden huomioiminen PDF-tiedostojen luomisessa hyödyttää kaikkia käyttäjiä: 
ruudunlukuohjelma voi lukea PDF-tiedoston sisällön ääneen, sisältö näkyy oikein myös pienessä 
mobiililaitteen näytössä ja sarkainjärjestys auttaa käyttäjiä täyttämään lomakkeen helpommin. 
 
PDF-tiedostosta ei vielä toistaiseksi saa täysin esteetöntä kaikille käyttäjille. Siitä voi kuitenkin 
tehdä esteettömämmän, kun tiedoston osat on ”tagitettu” eli merkitty kuten HTML-koodissa. 
Tällöin sisällön lukeminen esimerkiksi ruudunlukuohjelmalla onnistuu. Tätä varten tarvitaan 
Adoben Acrobat Professional tai Acrobat 3D ohjelma. Acrobat Reader ei riitä. 
 
PDF-tiedostojen esteettömyydessä on huomioitava seuraavat ominaisuudet: 
 

• Tiedoston tulee sisältää tekstiä. (ei esim. skannattuja kuvia). 
• Vaihtoehtoiset tekstikuvaukset kuvissa ja vuorovaikutteisissa lomakekentissä. 
• Kirjaisimet, jotka sallivat merkkien poimimisen tekstistä. 
• Lukemisjärjestys ja dokumentin rakennekoodit on määritelty. 
• Vuorovaikutteiset lomakekentät. 
• Navigointiapuvälineet (linkit, kirjanmerkit, otsikot, sarkainjärjestys). 
• Dokumentin kieli on asetettu. 
• Avustavaa ohjelmaa (esimerkiksi ruudunlukuohjelma) haittaamaton suojaus. 

 
Esteettömin tulos saadaan, kun huomioidaan esteettömyys jo lähdesovelluksessa. 
 

2 PDF-tiedoston luominen lähdesovelluksessa: MS Word 

2.1 Käytä tyylejä 

Luo dokumentti MS Word-ohjelmalla käyttämällä tyylejä rakenteen – otsikoiden, kappaleiden, 
listojen ja palstojen – merkitsemiseen.  

2.2 Kuvat 

Lisää kuviin niiden merkityksen kertova tekstivastike, jotta kuvan sisältö olisi saavutettavissa 
myös ruudunlukuohjelmaa käyttävälle. Klikkaa kuvaa hiiren oikealla painikkeella ja valitse 
Muotoile kuvaa (Format Picture) ja sieltä Web-välilehti. Kirjoita kuvan tekstivastike kohtaan 
Vaihtoehtoinen teksti (Alternative text). 
 



2.3 Taulukot 

Käytä taulukon tekemiseen Wordin taulukko-työkalua. Valitse yläreunan valikosta Taulukko ja 
sieltä Lisää - Taulukko (Table - Insert - Table). Tällöin myös ruudunlukuohjelma osaa lukea 
taulukon taulukoksi. 
 
Vältä laajojen, useammalle sivulle jatkuvien solujen tekemistä. Jos yhteen soluun tulee paljon 
tekstiä ja teksti uhkaa katketa kahdelle sivulle, toimi seuraavasti: 
 

1. Klikkaa sitä solua, joka katkeaa toiselle sivulle. 
2. Paina hiiren oikeaa näppäintä ja valitse taulukon ominaisuudet (Table properties). 
3. Valitse välilehti Rivi (Row) ja kohdassa Salli rivijako seuraavalle sivulle (Allow Row to 

Break Across Pages) poista ruksi. 

2.4 Linkit 

Jos dokumentissa on www-linkkejä tai dokumentin sisäisiä linkkejä, tee niistä hyperlinkit ja anna 
niille tekstikuvaukset (alt text). Tekstikuvauksen tulisi kuvata linkin sisältöä. Älä käytä ”Klikkaa 
tästä” -tyyppisiä tekstikuvauksia. 
 

1. Kirjoita linkiksi haluamasi teksti ja maalaa se. 
2. Paina hiiren oikeata painiketta ja valitse Hyperlinkki. 
3. a) Ulkoinen linkki: Kirjoita ylhäällä olevaan tekstikenttään linkkiä kuvaava nimi ja 

alhaalla olevaan tekstikenttään osoite, jonne haluat linkin vievän. 
4. b) Sisäinen linkki: Valitse vasemmasta reunasta ”Kohta tässä tiedostossa” (Place in 

this document) ja valitse se otsikko, johon haluat linkin vievän.  
 
HUOM! Acrobat ei osaa tulkita URL-osoitteita, jotka päättyvät kenoviivaan (esim. 
www.jyu.fi/tutkimus/). Vältä sen käyttämistä. 

2.5 Word-dokumentin kääntäminen PDF-tiedostoksi 

Kun olet tehnyt Word-dokumentin käyttämällä eri tyylejä, voit kääntää sen PDF-tiedostoksi. 
Tarkista vielä kääntämisen asetukset: Adobe PDF - Change Conversion Settings (vain 
englanniksi). 
 
Settings-välilehti: Tarkista, että kohta Enable accessibility and reflow with tagged PDF on 
valittu (Salli esteettömyys ja uudelleenjuoksutus kooditetussa PDF:ssa). 
 
Security-välilehti: Jos suojaat tiedoston sisältöä salasanalla, tarkista, että kohdassa Enable 
Text Access For Screen Reader Devices For The Visually Impaired on ruksi (Salli tekstin 
siirtäminen näytönlukulaitteeseen näkövammaisia varten). Tämä kohta on valittuna oletuksena. 
 
Word-välilehti: Saat linkit sisällysluettelosta otsikoihin ruksaamalla kohdan Convert cross-
references and tables of contents to links (Käännä ristiviitteet ja sisällysluettelot linkeiksi). 
 
Bookmarks-välilehti: Tarkista, että kohdat Convert Word Headings To Bookmarks sekä 
Convert Word Styles To Bookmarks ovat valittuina (Käännä Wordin otsikot kirjanmerkeiksi ja 
Käännä Wordin tyylit kirjanmerkeiksi). Tällöin kaikki muokkaamasi ja luomasi tyylit ovat 
eroteltavissa. 
 

http://www.jyu.fi/tutkimus/


2.6 PDF-tiedoston asetusten tarkistaminen kääntämisen jälkeen 
(Acrobat Professionalissa) 

2.6.1 Suojaus 

Voit säilyttää dokumentin suojausasetukset ja sallia näytönlukuohjelmien lukevan tekstin 
käyttämällä jotain seuraavista asetuksista. 
 

• Vähäinen suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – 
Vaihda asetukset – ruksaa Salli tekstin, kuvien ja muun sisällön kopioiminen. (Secure – 
Show security settings… - Password Security – Change Settings – Enable copying of 
text, images, and other).  

 
• Tehokas suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – 

Vaihda asetukset – ruksaa Salli tekstin siirtäminen näytönlukulaitteeseen 
näkövammaisia varten -vaihtoehto. Tämä asetus ohittaa dokumentin suojausasetukset 
ja antaa sisällön käyttöoikeudet vain avustavalle ohjelmalle, kuten 
näytönlukuohjelmalle. Tämä on oletuksena päällä. (Secure – Show security settings… 
- Password Security – Change Settings – Enable Text Access For Screen Reader 
Devices For The Visually Impaired). 

2.6.2 Kieli 

PDF-tiedoston kielen määrittäminen mahdollistaa oikean kielen ottamisen käyttöön tietyissä 
näytönlukuohjelmissa. 
 

• Koko dokumentin kieli: Tiedosto > Ominaisuudet  > Lisäasetukset-välilehti > 
Lukuasetukset-ruudun Kieli-valikosta. (Vaihtoehtoina löytyy mm. suomi, ruotsi, englanti, 
ranska, saksa, espanja, italia, japani, kiina). (File > Document Properties > Advanced > 
Language). 

• Jos kieli ei löydy valikosta: Kirjoita kielen ISO 639 -koodi Kieli-valikkon 
ensimmäiselle riville. Lisätietoja ISO-kielikoodeista on osoitteessa 
http://www.loc.gov/standards. 

• Dokumentin osien tai yksittäisten sanojen kieli: Valitse tekstielementti 
Koodimerkinnät-välilehdestä > Asetukset > Ominaisuudet > Koodimerkinnät-välilehti > 
valitse Kieli. (Tags > Options > Properties > Tags > Language). 

2.6.3 Lukemisjärjestys 

Tarkista lukemisjärjestys, jotta sisällön osat ovat rakenteellisesti oikeassa järjestyksessä. Näin 
sisältö on oikeassa järjestyksessä myös ruudunlukuohjelmaa käytettäessä. 
 

1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – 
Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…). 

2. Valitse Lukemisjärjestyksen muutos -valintaikkunasta Näytä sivun sisällön järjestys.  
3. Tarkista, että kaikki korostetut alueet ovat oikeassa järjestyksessä. (Tämä tehtävä 

helpottuu, jos suurennat dokumenttia näytössä.) 
4. Tarkista kaikkien korostettujen alueiden numerojärjestys. Jos juoksevasti numeroidut 

alueet eivät ole peräkkäin, muuta niiden järjestystä seuraavasti: Näytä Järjestys – 
Järjestys-välilehti – klikkaa siirrettävän kohteen numeroa – Valinnat – Leikkaa – valitse 
paikka – Valinnat – Liitä (Show Order Panel – Order –Options – Cut /Paste). 



HUOM!  
• Työkalu käytettävissä vain Acrobat 7:ssa. 
• Tallenna tiedosto ennen kuin käytät Lukemisjärjestyksen muutostyökalua, sillä 

työkalulla tehtyjä muutoksia ei voi kumota! 
• Työkalu tukee vain yhdeksää eri tagia ja on hieman hankala käyttää. 

2.6.4 Sarkaimen järjestys 

Aseta sarkaimen järjestys seuraamaan dokumentin rakennetta, jotta dokumentin sisältöä voi 
selata sujuvasti tabulaattorilla. 
 

1. Avaa Sivut-välilehti (Pages). 
2. Valitse kaikki sivut Ctrl+A (Windows) tai Komento+A (Mac OS). 
3. Valitse välilehdeltä Valinnat – Sivun ominaisuudet (Options – Page Properties). 
4. Valitse Sarkaimen järjestys -välilehti (Tab order) ja ruksaa kohta käytä dokumentin 

rakennetta (Use document structure). 

3 PDF-lomakkeen tekeminen 

3.1 Lomakkeen suunnittelussa huomioitavaa 

• Lisää otsikot, ohjeet ja kentät käyttäjän lisäämiä tietoja varten. 
Vähimmäisvaatimus on se, että lisäät jokaiseen kenttään otsikon. Lisää myös 
erityisohjeita kenttiin, joissa niitä tarvitaan.  

• Käytä grafiikkatyökaluja viivojen ja kehysten piirtämiseen (esim. tekstilaatikot, 
viivat). Älä käytä ala- ja pystyviivojen kaltaisia merkkejä, koska ne johtavat 
näytönlukuohjelman harhaan. 

• Lisää lomakekenttiin lyhyet mutta kattavat kuvaukset (ks. 2.2 Kuvat kuvaustekstin 
lisääminen). Tällöin näytönlukuohjelmat pystyvät ilmaisemaan kentät käyttäjälle. 
Ohjelma lukee kuvauksen ääneen, kun käyttäjä siirtyy kenttään sarkainnäppäimellä. 
Esimerkiksi etunimelle tarkoitettuun kenttään sopii kuvaukseksi "Etunimi". Älä käytä 
kuvauksessa ohjeita (esimerkiksi "Kirjoita etunimesi"). 

3.2 Lomakkeen toteuttaminen 

1. Suunnittele ja muotoile sisältö ja lomakekenttien otsikot lähdesovelluksessa (esim. MS 
Word, LiveCycle Designer, Acrobat Professional). 

2. Sijoita jokainen otsikko uudelle riville. 
3. Tallenna ja käännä se kooditetuksi PDF-dokumentiksi. 
4. Avaa dokumentti Acrobat Professionalissa. 
5. Aktivoi Koodi-välilehti (Näytä – Navigaatio – Koodi / View – Navigation tabs – Tags) ja 

valitse Valikosta (Options) "Highlight Content" and "Tag Annotations". 
6. Valitse lomakekentän otsikko koodipuusta, jolloin kohta korostuu itse dokumentissa. 
7. Valitse sopiva lomakkeen kenttä lomakkeen työkaluriviltä (esim. tekstikenttä, 

radiopainike) (Työkalut - / Tools – Advanced Editing).  
8. Maalaa se alue, johon valittu lomakkeen kenttä tulee.  
9. Asettele kenttä sopivalle paikalle. 
10. Valitse ominaisuudet (Properties) hiiren oikealla painikkeella ja Yleiset-välilehdellä 

(General) kirjoita kentän otsikko kohtaan Tooltip. Ruudunlukuohjelmat lukevat tämän 
tekstin käyttäjälle. 

11. Määrittele asetukset: tarkista kieli, lukujärjestys ja sarkaimen järjestys vastaamaan 
dokumentin järjestystä. 



3.3 Työkalut 

LiveCycle Designer: Vain lomakekenttiä sisältäviin monimutkaisiin lomakkeisiin 
(Ilmainen kokeilukäyttö, maksullinen). 
 
Acrobat Professional tai Acrobat 3D: Lomakekenttiä ja tekstiä sisältäviin lomakkeisiin, lisää 
lomakekentät ja suorittaa esteettömyystehtävät dokumentin muissa osissa. 
(maksullinen ohjelma) 
 
MS Word: sopii peruskäyttöön, vaatii tarkistusta kääntämisen jälkeen. 
 
HUOM! 

4 Web-sivujen kääntäminen PDF-tiedostoksi 

Saat laatimistasi Web-sivuista mahdollisimman esteettömät PDF-tiedostot muodostamalla 
HTML-koodeilla loogisen lukemisjärjestyksen. Huomaa, että myös itse sivujen tulee olla 
esteettömät! Saat parhaat tulokset noudattamalla World Wide Web Consortiumin (W3C) 
julkaisemia ohjeita esteettömien Web-sivujen laatimisesta (Web Content Accessibility Guidelines) 
www.w3.org. Www-sivujen kääntäminen PDF-tiedostoksi on perusteltua esimerkiksi tulostusta 
varten. 
 

1. Avaa Acrobat Proffessional. 
2. Valitse Tiedosto  > Luo PDF > Web-sivusta. (File > Create PDF > From web page). 
3. Määritä URL-osoitteeksi Web-sivun osoite tai siirry kyseiseen Web-osoitteeseen. 
4. Valitse Asetukset (Settings). 
5. Valitse Yleiset-välilehdestä Luo PDF-koodimerkinnät ja napsauta OK (General – 

Create PDF tags). 
6. Valitse muut haluamasi asetukset ja napsauta sitten Luo (Create). 
7. Tarkista ja arvioi tulos. Käytä Lukemisjärjestyksen muutostyökalua (TouchUp Reading 

Order) järjestyksen tarkistamiseen, määritä kieli- ja suojausasetukset. 
 
HUOM! 

• Vaatii melko paljon käsityötä esteettömyysasetusten ja lukemisjärjestyksen oikomiseen 
kääntämisen jälkkeen. 

• Harkitse tarkkaan, missä tilanteessa tarpeellista. 

5 Valmiiden PDF-tiedostojen muokkaaminen esteettömiksi 

5.1 Huomioitavaa 

• Vaatii Acrobat Professionalin. 
• Muokkaaminen on työlästä. 
• Vaatii jonkin verran HTML-osaamista. 
• Esteettömyys kannattaa huomioida jo lähdesovelluksessa ennen kääntämistä. 

5.2 Lisää koodimerkinnät 

Jos PDF-tiedostossa ei ole koodimerkintöjä, voit lisätä ne Lisää koodimerkinnät dokumenttiin 
-komennolla. 

http://www.w3.org/


 
1. Avaa PDF-tiedosto. 
2. Valitse Lisäasetukset > Käytettävyys > Lisää koodimerkinnät dokumenttiin (Advanced 

> Accessibility > Add Tags to Document). 
 
HUOM! 

• Lisää koodimerkinnät dokumenttiin -komento poistaa dokumentissa ennestään olleet 
koodimerkinnät. 

• Toiminto ei ole täydellinen vaan vaatii tarkistusta ja muokkausta myös käsin. 

5.3 Tarkista ja korjaa lukemisjärjestys 

1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – 
Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…). 

2. Valitse Lukemisjärjestyksen muutos -valintaikkunasta Näytä sivun sisällön järjestys.  
3. Tarkista, että kaikki korostetut alueet ovat oikeassa järjestyksessä. (Tämä tehtävä 

helpottuu, jos suurennat dokumenttia näytössä). 
4. Tarkista kaikkien korostettujen alueiden numerojärjestys. Jos juoksevasti numeroidut 

alueet eivät ole peräkkäin, muuta niiden järjestystä seuraavasti: Näytä Järjestys – 
Järjestys-välilehti – klikkaa siirrettävän kohteen numeroa – Valinnat – Leikkaa – valitse 
paikka – Valinnat – Liitä (Show Order Panel – Order –Options – Cut /Paste). 

 
HUOM!  

• Tallenna tiedosto ennen kuin käytät Lukemisjärjestyksen muutostyökalua, sillä 
työkalulla tehtyjä muutoksia ei voi kumota! 

• Työkalu käytettävissä vain Acrobat 7:ssa. 
• Työkalu tukee vain yhdeksää eri tagia ja on hieman hankala käyttää. 

5.4 Vaihtoehtoisen tekstin lisääminen kuville ja taulukoille 

Jotta näytönlukuohjelma voi tunnistaa ja lukea kuvan/taulukon, tulee siihen lisätä vaihtoehtoinen 
teksti. 
 

1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – 
Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…). 

2. Ruksaa kaikki kolme vaihtoehtoa Lukemisjärjestyksen muutos –valintaikkunasta 
(TouchUp Reading Order) 

3. Klikkaa kuvaa ja valitse  Kuva (Figure). 
4. Napsauta kuvaa hiiren oikealla painikkeella ja valitse Muokkaa vaihtoehtoista tekstiä 

(Edit Alternate Text). 
5. Kirjoita vaihtoehtoinen teksti ja napsauta OK. 

5.5 Taulukoiden koodimerkintöjen muokkaaminen 

Taulukot ovat näytönlukuohjelmille suuri haaste, koska ne sisältävät tekstiä tai lukuja 
visuaalisessa muodossa.  
 
Parhaisiin tuloksiin päästään lisäämällä koodimerkinnät samalla ohjelmalla, jolla PDF-tiedosto 
luodaan. Jos PDF-tiedostossa ei ole koodimerkintöjä, voit lisätä ne Lisää koodimerkinnät 
dokumenttiin -komennolla (Add tags to Document). Tämä komento tunnistaa useimmat 
taulukot oikein, mutta ei ehkä tunnista taulukkoa, josta puuttuvat selvät reunaviivat, otsikot, 
sarakkeet ja rivit. Käytä lukemisjärjestyksen muutostyökalua, kun haluat selvittää, onko 



ohjelma tunnistanut taulukon oikein, sekä korjata tunnistusvirheet. Voit lisätä taulukkoihin ja 
niiden soluihin erikoismuotoiluja käyttämällä Koodimerkinnät-välilehteä (Tags). 

1. Valitse lukemisjärjestyksen muutostyökalu ja napsauta sitten Näytä taulukot ja kuvat –
painiketta (Show Tables and Figures).  

2. Ellei taulukkoa ole selvästi otsikoitu dokumenttiruudussa, valitse koko taulukko vetämällä 
hiirtä ja napsauta sitten valintaikkunan Taulukko-painiketta (Table). 

3. Napsauta Näytä taulukon solut ja varmista, että taulukon kaikki solut on määritetty 
erillisiksi elementeiksi (Show Table Cells).  

4. Jos solut eivät näy erillisinä elementteinä, tee jokin seuraavista toimista: 
• Jos yksi solu tai useita soluja on yhdistetty, valitse lukemisjärjestyksen 

muutostyökalulla alue yhdestä solusta ja napsauta sitten valintaikkunan Solu-painiketta 
(Cell). Toista tämä kunkin yhdistetyn solun kohdalla. 

• Jos soluja ei ole korostettu, taulukossa ei ehkä ole käytetty vakiomuotoilua. Luo 
taulukko uudelleen lähdesovelluksella. 

 
Jos taulukossa on soluja, joiden pitäisi ulottua kahteen tai useampaan sarakkeeseen, aseta 
koodimerkintärakenteessa näiden rivien ColSpan- ja RowSpan-määritteet. 
 
HUOM! 

• Todella työlästä! 
• Vaatii HTML-osaamista. 

5.6 Esteettömien linkkien lisääminen 

1. Valitse teksti tai objekti, jota varten haluat luoda linkin (Käytä Valinta-työkalua / Select). 
2. Napsauta hiiren kakkospainikkeella valintaa ja valitse pikavalikosta Luo linkki (Create 

Link). 
3. Valitse Luo linkki -valintaikkunasta sopivat asetukset. Määritä sitten URL-osoite, 

sivunäkymä tai tiedosto linkin kohteeksi näytön ohjeiden mukaan.  
 
Linkin kohdalta valittu teksti muuttuu normaalisti linkkitekstiksi. Kun olet lisännyt kaikki linkit, voit 
muokata koodimerkintäpuuta (Tags) ja lisätä linkkeihin vaihtoehtoiset tekstit PDF-tiedoston 
esteettömyyden parantamiseksi. 
 
HUOM!  

• Vaatii Acrobat Professionalin 
• Acrobat ei osaa tulkita URL-osoitteita, jotka päättyvät kenoviivaan (esim. 

www.jyu.fi/tutkimus/). Vältä sen käyttämistä. 
 

5.7 Asetusten tarkastaminen 

5.7.1 Kieli 

PDF-tiedoston kielen määrittäminen mahdollistaa oikean kielen ottamisen käyttöön tietyissä 
näytönlukuohjelmissa. 
 

• Koko dokumentin kieli: Tiedosto > Ominaisuudet  > Lisäasetukset-välilehti > 
Lukuasetukset-ruudun Kieli-valikosta. (Vaihtoehtoina löytyy mm. suomi, ruotsi, englanti, 
ranska, saksa, espanja, italia, japani, kiina). (File > Document Properties > Advanced > 
Language). 

http://www.jyu.fi/tutkimus/


• Jos kieli ei löydy valikosta: Kirjoita kielen ISO 639 -koodi Kieli-valikkon 
ensimmäiselle riville. Lisätietoja ISO-kielikoodeista on osoitteessa 
http://www.loc.gov/standards. 

• Dokumentin osien tai yksittäisten sanojen kieli: Valitse tekstielementti 
Koodimerkinnät-välilehdestä > Asetukset > Ominaisuudet > Koodimerkinnät-välilehti > 
valitse Kieli. (Tags > Options > Properties > Tags > Language). 

5.7.2 Suojaus 

Voit säilyttää dokumentin suojausasetukset ja sallia näytönlukuohjelmien lukevan tekstin 
käyttämällä jotain seuraavista asetuksista. 
 

• Vähäinen suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – 
Vaihda asetukset – ruksaa Salli tekstin, kuvien ja muun sisällön kopioiminen. (Secure – 
Show security settings… - Password Security – Change Settings – Enable copying of 
text, images, and other).  

 
• Tehokas suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – 

Vaihda asetukset – ruksaa Salli tekstin siirtäminen näytönlukulaitteeseen 
näkövammaisia varten -vaihtoehto. Tämä asetus ohittaa dokumentin suojausasetukset 
ja antaa sisällön käyttöoikeudet vain avustavalle ohjelmalle, kuten 
näytönlukuohjelmalle. Tämä on oletuksena päällä. (Secure – Show security settings… 
- Password Security – Change Settings – Enable Text Access For Screen Reader 
Devices For The Visually Impaired). 

 

5.7.3 Sarkaimen järjestys 

Aseta sarkaimen järjestys seuraamaan dokumentin rakennetta, jotta dokumentin sisältöä voi 
selata sujuvasti tabulaattorilla. 
 

1. Avaa Sivut-välilehti (Pages). 
2. Valitse kaikki sivut Ctrl+A (Windows) tai Komento+A (Mac OS). 
3. Valitse välilehdeltä Valinnat – Sivun ominaisuudet (Options – Page Properties). 
4. Valitse Sarkaimen järjestys -välilehti (Tab order) ja ruksaa kohta käytä dokumentin 

rakennetta (Use document structure). 

6 Esteettömyyden tarkistaminen 

Hyvä tapa testata dokumentin esteettömyys on kokeilla siihen työkaluja, joita lukijat käyttävät. 
PDF-tiedoston esteettömyyttä voi tarkistaa osin myös Acrobatin sisältämillä menetelmillä, jotka 
eivät kuitenkaan ole kattavia. 
 
Pikatarkistus 

• tarkistaa dokumentin rakennekoodit, hakukelpoisen tekstin ja esteettömyyteen liittyvät 
suojausasetukset. 

• Ei kiinnitä huomiota esim. kuvien tai taulukoiden kuvausteksteihin tai järjestykseen. 
• Paina Vaihto+Ctrl+6 (Windows) tai Vaihto+Komento+6 (Mac OS). 

 
Täydellinen tarkistus (Versio 7) 



• Selvittää PDF-tiedoston esteettömyysominaisuudet, esimerkiksi kirjasimet, jotka 
voidaan luotettavasti muuntaa Unicode-tekstiksi ja kuvien/taulukoiden kuvaustekstit. 

• Esittää vihjeitä virheiden korjaamista varten. 
• Täydellinen tarkistus voi kestää kauan, joten kannattaa valita pieni sivualue kerrallaan. 

Tarkistuksen voi keskeyttää painamalla Esc-näppäintä.  
1. Lisäasetukset > Käytettävyys > Täydellinen tarkistus (Advanced – Accessibility – 

Full Check).  
2. Valitse, miten tulokset näytetään, mikä sivualue tarkistetaan ja mihin 

esteettömyysongelmiin kiinnitetään huomiota. 
3. Napsauta Aloita tarkistus (Start Checking).  

 
HUOM! 
Nämä esteettömyystyökalut eivät ole täydellisiä eivätkä ota huomioon kaikkia saatavilla olevia 
esteettömyysehtoja. Työkalujen avulla voi kuitenkin löytää dokumentissa olevia esteellisiä kohtia. 
 
Muut tarkistuskeinot 

• Tarkista lukemisjärjestys nopeasti uudelleenjuoksutusnäkymässä (Näytä – 
Uudelleenjuoksutus / View – Reflow).  

• Kokeile Lue ääneen -toimintoa, jotta tiedät, miten tämä tekstiä puheeksi muuntava 
työkalu toimii: Katso – Lue ääneen (View – Read aloud). HUOM! Toimii vain 
englanniksi. 

• Tallenna dokumentti tekstinä ja avaa tekstitiedosto tekstinkäsittelyohjelmalla, jotta 
tiedät, miten pistekirjoitustulostin tulostaa sen. 

7 Lähteet: 

Esteettömyys, tunnisteet ja uudelleenjuoksutus. Adoben esteettömyysohjeistus. 
http://help.adobe.com/fi_FI/Acrobat/8.0/Professional/help.html?content=WS58a04a822e3e5010
2bd615109794195ff-7d23.html
 
Creating accessible PDF Documents with Adobe Acrobat 7.0 
http://www.adobe.com/enterprise/accessibility/pdfs/acro7_pg_ue.pdf
 
PDF Accessibility. Defining Acrobat PDF Accessibility
http://www.webaim.org/techniques/acrobat/
 
Accessible Forms-PDF. Adobe Acrobat Professional. 
http://www.ncsu.edu/it/access/tutorials/forms/formpdf.php

http://help.adobe.com/fi_FI/Acrobat/8.0/Professional/help.html?content=WS58a04a822e3e50102bd615109794195ff-7d23.html
http://help.adobe.com/fi_FI/Acrobat/8.0/Professional/help.html?content=WS58a04a822e3e50102bd615109794195ff-7d23.html
http://www.adobe.com/enterprise/accessibility/pdfs/acro7_pg_ue.pdf
http://www.webaim.org/techniques/acrobat/
http://www.ncsu.edu/it/access/tutorials/forms/formpdf.php

	PDF-tiedostot ja esteettömyys
	1 Johdanto
	PDF-tiedostoa käytetään paljon verkossa, koska se säilyttää sisällön ulkoasun samana kaikissa käyttöjärjestelmissä sekä tulostettaessa. Toistaiseksi pelkkä PDF-muoto ei kuitenkaan ole riittävä, koska esimerkiksi ruudunlukijaa käyttävälle PDF-tiedosto voi olla lähes saavuttamaton. Esteettömin toimintatapa on tarjota sekä PDF- että HTML-tiedosto.
	Esteettömyyden huomioiminen PDF-tiedostojen luomisessa hyödyttää kaikkia käyttäjiä: ruudunlukuohjelma voi lukea PDF-tiedoston sisällön ääneen, sisältö näkyy oikein myös pienessä mobiililaitteen näytössä ja sarkainjärjestys auttaa käyttäjiä täyttämään lomakkeen helpommin.
	PDF-tiedostosta ei vielä toistaiseksi saa täysin esteetöntä kaikille käyttäjille. Siitä voi kuitenkin tehdä esteettömämmän, kun tiedoston osat on ”tagitettu” eli merkitty kuten HTML-koodissa. Tällöin sisällön lukeminen esimerkiksi ruudunlukuohjelmalla onnistuu. Tätä varten tarvitaan Adoben Acrobat Professional tai Acrobat 3D ohjelma. Acrobat Reader ei riitä.
	PDF-tiedostojen esteettömyydessä on huomioitava seuraavat ominaisuudet:
	 Tiedoston tulee sisältää tekstiä. (ei esim. skannattuja kuvia).
	 Vaihtoehtoiset tekstikuvaukset kuvissa ja vuorovaikutteisissa lomakekentissä.
	 Kirjaisimet, jotka sallivat merkkien poimimisen tekstistä.
	 Lukemisjärjestys ja dokumentin rakennekoodit on määritelty.
	 Vuorovaikutteiset lomakekentät.
	 Navigointiapuvälineet (linkit, kirjanmerkit, otsikot, sarkainjärjestys).
	 Dokumentin kieli on asetettu.
	 Avustavaa ohjelmaa (esimerkiksi ruudunlukuohjelma) haittaamaton suojaus.
	Esteettömin tulos saadaan, kun huomioidaan esteettömyys jo lähdesovelluksessa.
	2 PDF-tiedoston luominen lähdesovelluksessa: MS Word
	2.1 Käytä tyylejä

	Luo dokumentti MS Word-ohjelmalla käyttämällä tyylejä rakenteen – otsikoiden, kappaleiden, listojen ja palstojen – merkitsemiseen. 
	2.2 Kuvat

	Lisää kuviin niiden merkityksen kertova tekstivastike, jotta kuvan sisältö olisi saavutettavissa myös ruudunlukuohjelmaa käyttävälle. Klikkaa kuvaa hiiren oikealla painikkeella ja valitse Muotoile kuvaa (Format Picture) ja sieltä Web-välilehti. Kirjoita kuvan tekstivastike kohtaan Vaihtoehtoinen teksti (Alternative text).
	2.3 Taulukot

	Käytä taulukon tekemiseen Wordin taulukko-työkalua. Valitse yläreunan valikosta Taulukko ja sieltä Lisää - Taulukko (Table - Insert - Table). Tällöin myös ruudunlukuohjelma osaa lukea taulukon taulukoksi.
	Vältä laajojen, useammalle sivulle jatkuvien solujen tekemistä. Jos yhteen soluun tulee paljon tekstiä ja teksti uhkaa katketa kahdelle sivulle, toimi seuraavasti:
	1. Klikkaa sitä solua, joka katkeaa toiselle sivulle.
	2. Paina hiiren oikeaa näppäintä ja valitse taulukon ominaisuudet (Table properties).
	3. Valitse välilehti Rivi (Row) ja kohdassa Salli rivijako seuraavalle sivulle (Allow Row to Break Across Pages) poista ruksi.
	2.4 Linkit

	Jos dokumentissa on www-linkkejä tai dokumentin sisäisiä linkkejä, tee niistä hyperlinkit ja anna niille tekstikuvaukset (alt text). Tekstikuvauksen tulisi kuvata linkin sisältöä. Älä käytä ”Klikkaa tästä” -tyyppisiä tekstikuvauksia.
	1. Kirjoita linkiksi haluamasi teksti ja maalaa se.
	2. Paina hiiren oikeata painiketta ja valitse Hyperlinkki.
	3. a) Ulkoinen linkki: Kirjoita ylhäällä olevaan tekstikenttään linkkiä kuvaava nimi ja alhaalla olevaan tekstikenttään osoite, jonne haluat linkin vievän.
	4. b) Sisäinen linkki: Valitse vasemmasta reunasta ”Kohta tässä tiedostossa” (Place in this document) ja valitse se otsikko, johon haluat linkin vievän. 
	HUOM! Acrobat ei osaa tulkita URL-osoitteita, jotka päättyvät kenoviivaan (esim. www.jyu.fi/tutkimus/). Vältä sen käyttämistä.
	2.5 Word-dokumentin kääntäminen PDF-tiedostoksi

	Kun olet tehnyt Word-dokumentin käyttämällä eri tyylejä, voit kääntää sen PDF-tiedostoksi. Tarkista vielä kääntämisen asetukset: Adobe PDF - Change Conversion Settings (vain englanniksi).
	Settings-välilehti: Tarkista, että kohta Enable accessibility and reflow with tagged PDF on valittu (Salli esteettömyys ja uudelleenjuoksutus kooditetussa PDF:ssa).
	Security-välilehti: Jos suojaat tiedoston sisältöä salasanalla, tarkista, että kohdassa Enable Text Access For Screen Reader Devices For The Visually Impaired on ruksi (Salli tekstin siirtäminen näytönlukulaitteeseen näkövammaisia varten). Tämä kohta on valittuna oletuksena.
	Word-välilehti: Saat linkit sisällysluettelosta otsikoihin ruksaamalla kohdan Convert cross-references and tables of contents to links (Käännä ristiviitteet ja sisällysluettelot linkeiksi).
	Bookmarks-välilehti: Tarkista, että kohdat Convert Word Headings To Bookmarks sekä Convert Word Styles To Bookmarks ovat valittuina (Käännä Wordin otsikot kirjanmerkeiksi ja Käännä Wordin tyylit kirjanmerkeiksi). Tällöin kaikki muokkaamasi ja luomasi tyylit ovat eroteltavissa.
	2.6 PDF-tiedoston asetusten tarkistaminen kääntämisen jälkeen (Acrobat Professionalissa)
	2.6.1 Suojaus


	Voit säilyttää dokumentin suojausasetukset ja sallia näytönlukuohjelmien lukevan tekstin käyttämällä jotain seuraavista asetuksista.
	 Vähäinen suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – Vaihda asetukset – ruksaa Salli tekstin, kuvien ja muun sisällön kopioiminen. (Secure – Show security settings… - Password Security – Change Settings – Enable copying of text, images, and other). 
	 Tehokas suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – Vaihda asetukset – ruksaa Salli tekstin siirtäminen näytönlukulaitteeseen näkövammaisia varten -vaihtoehto. Tämä asetus ohittaa dokumentin suojausasetukset ja antaa sisällön käyttöoikeudet vain avustavalle ohjelmalle, kuten näytönlukuohjelmalle. Tämä on oletuksena päällä. (Secure – Show security settings… - Password Security – Change Settings – Enable Text Access For Screen Reader Devices For The Visually Impaired).
	2.6.2 Kieli

	PDF-tiedoston kielen määrittäminen mahdollistaa oikean kielen ottamisen käyttöön tietyissä näytönlukuohjelmissa.
	 Koko dokumentin kieli: Tiedosto > Ominaisuudet  > Lisäasetukset-välilehti > Lukuasetukset-ruudun Kieli-valikosta. (Vaihtoehtoina löytyy mm. suomi, ruotsi, englanti, ranska, saksa, espanja, italia, japani, kiina). (File > Document Properties > Advanced > Language).
	 Jos kieli ei löydy valikosta: Kirjoita kielen ISO 639 -koodi Kieli-valikkon ensimmäiselle riville. Lisätietoja ISO-kielikoodeista on osoitteessa http://www.loc.gov/standards.
	 Dokumentin osien tai yksittäisten sanojen kieli: Valitse tekstielementti Koodimerkinnät-välilehdestä > Asetukset > Ominaisuudet > Koodimerkinnät-välilehti > valitse Kieli. (Tags > Options > Properties > Tags > Language).
	2.6.3 Lukemisjärjestys

	Tarkista lukemisjärjestys, jotta sisällön osat ovat rakenteellisesti oikeassa järjestyksessä. Näin sisältö on oikeassa järjestyksessä myös ruudunlukuohjelmaa käytettäessä.
	1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…).
	2. Valitse Lukemisjärjestyksen muutos -valintaikkunasta Näytä sivun sisällön järjestys. 
	3. Tarkista, että kaikki korostetut alueet ovat oikeassa järjestyksessä. (Tämä tehtävä helpottuu, jos suurennat dokumenttia näytössä.)
	4. Tarkista kaikkien korostettujen alueiden numerojärjestys. Jos juoksevasti numeroidut alueet eivät ole peräkkäin, muuta niiden järjestystä seuraavasti: Näytä Järjestys – Järjestys-välilehti – klikkaa siirrettävän kohteen numeroa – Valinnat – Leikkaa – valitse paikka – Valinnat – Liitä (Show Order Panel – Order –Options – Cut /Paste).
	HUOM! 
	 Työkalu käytettävissä vain Acrobat 7:ssa.
	 Tallenna tiedosto ennen kuin käytät Lukemisjärjestyksen muutostyökalua, sillä työkalulla tehtyjä muutoksia ei voi kumota!
	 Työkalu tukee vain yhdeksää eri tagia ja on hieman hankala käyttää.
	2.6.4 Sarkaimen järjestys

	Aseta sarkaimen järjestys seuraamaan dokumentin rakennetta, jotta dokumentin sisältöä voi selata sujuvasti tabulaattorilla.
	1. Avaa Sivut-välilehti (Pages).
	2. Valitse kaikki sivut Ctrl+A (Windows) tai Komento+A (Mac OS).
	3. Valitse välilehdeltä Valinnat – Sivun ominaisuudet (Options – Page Properties).
	4. Valitse Sarkaimen järjestys -välilehti (Tab order) ja ruksaa kohta käytä dokumentin rakennetta (Use document structure).
	3 PDF-lomakkeen tekeminen
	3.1 Lomakkeen suunnittelussa huomioitavaa

	 Lisää otsikot, ohjeet ja kentät käyttäjän lisäämiä tietoja varten. Vähimmäisvaatimus on se, että lisäät jokaiseen kenttään otsikon. Lisää myös erityisohjeita kenttiin, joissa niitä tarvitaan. 
	 Käytä grafiikkatyökaluja viivojen ja kehysten piirtämiseen (esim. tekstilaatikot, viivat). Älä käytä ala- ja pystyviivojen kaltaisia merkkejä, koska ne johtavat näytönlukuohjelman harhaan.
	 Lisää lomakekenttiin lyhyet mutta kattavat kuvaukset (ks. 2.2 Kuvat kuvaustekstin lisääminen). Tällöin näytönlukuohjelmat pystyvät ilmaisemaan kentät käyttäjälle. Ohjelma lukee kuvauksen ääneen, kun käyttäjä siirtyy kenttään sarkainnäppäimellä. Esimerkiksi etunimelle tarkoitettuun kenttään sopii kuvaukseksi "Etunimi". Älä käytä kuvauksessa ohjeita (esimerkiksi "Kirjoita etunimesi").
	3.2 Lomakkeen toteuttaminen

	1. Suunnittele ja muotoile sisältö ja lomakekenttien otsikot lähdesovelluksessa (esim. MS Word, LiveCycle Designer, Acrobat Professional).
	2. Sijoita jokainen otsikko uudelle riville.
	3. Tallenna ja käännä se kooditetuksi PDF-dokumentiksi.
	4. Avaa dokumentti Acrobat Professionalissa.
	5. Aktivoi Koodi-välilehti (Näytä – Navigaatio – Koodi / View – Navigation tabs – Tags) ja valitse Valikosta (Options) "Highlight Content" and "Tag Annotations".
	6. Valitse lomakekentän otsikko koodipuusta, jolloin kohta korostuu itse dokumentissa.
	7. Valitse sopiva lomakkeen kenttä lomakkeen työkaluriviltä (esim. tekstikenttä, radiopainike) (Työkalut - / Tools – Advanced Editing). 
	8. Maalaa se alue, johon valittu lomakkeen kenttä tulee. 
	9. Asettele kenttä sopivalle paikalle.
	10. Valitse ominaisuudet (Properties) hiiren oikealla painikkeella ja Yleiset-välilehdellä (General) kirjoita kentän otsikko kohtaan Tooltip. Ruudunlukuohjelmat lukevat tämän tekstin käyttäjälle.
	11. Määrittele asetukset: tarkista kieli, lukujärjestys ja sarkaimen järjestys vastaamaan dokumentin järjestystä.
	3.3 Työkalut

	LiveCycle Designer: Vain lomakekenttiä sisältäviin monimutkaisiin lomakkeisiin
	(Ilmainen kokeilukäyttö, maksullinen).
	Acrobat Professional tai Acrobat 3D: Lomakekenttiä ja tekstiä sisältäviin lomakkeisiin, lisää lomakekentät ja suorittaa esteettömyystehtävät dokumentin muissa osissa.
	(maksullinen ohjelma)
	MS Word: sopii peruskäyttöön, vaatii tarkistusta kääntämisen jälkeen.
	HUOM!
	4 Web-sivujen kääntäminen PDF-tiedostoksi
	Saat laatimistasi Web-sivuista mahdollisimman esteettömät PDF-tiedostot muodostamalla HTML-koodeilla loogisen lukemisjärjestyksen. Huomaa, että myös itse sivujen tulee olla esteettömät! Saat parhaat tulokset noudattamalla World Wide Web Consortiumin (W3C) julkaisemia ohjeita esteettömien Web-sivujen laatimisesta (Web Content Accessibility Guidelines) www.w3.org. Www-sivujen kääntäminen PDF-tiedostoksi on perusteltua esimerkiksi tulostusta varten.
	1. Avaa Acrobat Proffessional.
	2. Valitse Tiedosto  > Luo PDF > Web-sivusta. (File > Create PDF > From web page).
	3. Määritä URL-osoitteeksi Web-sivun osoite tai siirry kyseiseen Web-osoitteeseen.
	4. Valitse Asetukset (Settings).
	5. Valitse Yleiset-välilehdestä Luo PDF-koodimerkinnät ja napsauta OK (General – Create PDF tags).
	6. Valitse muut haluamasi asetukset ja napsauta sitten Luo (Create).
	7. Tarkista ja arvioi tulos. Käytä Lukemisjärjestyksen muutostyökalua (TouchUp Reading Order) järjestyksen tarkistamiseen, määritä kieli- ja suojausasetukset.
	HUOM!
	 Vaatii melko paljon käsityötä esteettömyysasetusten ja lukemisjärjestyksen oikomiseen kääntämisen jälkkeen.
	 Harkitse tarkkaan, missä tilanteessa tarpeellista.
	5 Valmiiden PDF-tiedostojen muokkaaminen esteettömiksi
	5.1 Huomioitavaa

	 Vaatii Acrobat Professionalin.
	 Muokkaaminen on työlästä.
	 Vaatii jonkin verran HTML-osaamista.
	 Esteettömyys kannattaa huomioida jo lähdesovelluksessa ennen kääntämistä.
	5.2 Lisää koodimerkinnät

	Jos PDF-tiedostossa ei ole koodimerkintöjä, voit lisätä ne Lisää koodimerkinnät dokumenttiin -komennolla.
	1. Avaa PDF-tiedosto.
	2. Valitse Lisäasetukset > Käytettävyys > Lisää koodimerkinnät dokumenttiin (Advanced > Accessibility > Add Tags to Document).
	 Lisää koodimerkinnät dokumenttiin -komento poistaa dokumentissa ennestään olleet koodimerkinnät.
	 Toiminto ei ole täydellinen vaan vaatii tarkistusta ja muokkausta myös käsin.
	5.3 Tarkista ja korjaa lukemisjärjestys

	1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…).
	2. Valitse Lukemisjärjestyksen muutos -valintaikkunasta Näytä sivun sisällön järjestys. 
	3. Tarkista, että kaikki korostetut alueet ovat oikeassa järjestyksessä. (Tämä tehtävä helpottuu, jos suurennat dokumenttia näytössä).
	4. Tarkista kaikkien korostettujen alueiden numerojärjestys. Jos juoksevasti numeroidut alueet eivät ole peräkkäin, muuta niiden järjestystä seuraavasti: Näytä Järjestys – Järjestys-välilehti – klikkaa siirrettävän kohteen numeroa – Valinnat – Leikkaa – valitse paikka – Valinnat – Liitä (Show Order Panel – Order –Options – Cut /Paste).
	HUOM! 
	 Tallenna tiedosto ennen kuin käytät Lukemisjärjestyksen muutostyökalua, sillä työkalulla tehtyjä muutoksia ei voi kumota!
	 Työkalu käytettävissä vain Acrobat 7:ssa.
	 Työkalu tukee vain yhdeksää eri tagia ja on hieman hankala käyttää.
	5.4 Vaihtoehtoisen tekstin lisääminen kuville ja taulukoille

	Jotta näytönlukuohjelma voi tunnistaa ja lukea kuvan/taulukon, tulee siihen lisätä vaihtoehtoinen teksti.
	1. Valitse lukemisjärjestyksen muutostyökalu: Lisäasetukset – Käytettävyys – Lukemisjärjestyksen muutos (Advanced – Accessibility – TouchUp Reading Order…).
	2. Ruksaa kaikki kolme vaihtoehtoa Lukemisjärjestyksen muutos –valintaikkunasta (TouchUp Reading Order)
	3. Klikkaa kuvaa ja valitse  Kuva (Figure).
	4. Napsauta kuvaa hiiren oikealla painikkeella ja valitse Muokkaa vaihtoehtoista tekstiä (Edit Alternate Text).
	5. Kirjoita vaihtoehtoinen teksti ja napsauta OK.
	5.5 Taulukoiden koodimerkintöjen muokkaaminen

	Taulukot ovat näytönlukuohjelmille suuri haaste, koska ne sisältävät tekstiä tai lukuja visuaalisessa muodossa. 
	Parhaisiin tuloksiin päästään lisäämällä koodimerkinnät samalla ohjelmalla, jolla PDF-tiedosto luodaan. Jos PDF-tiedostossa ei ole koodimerkintöjä, voit lisätä ne Lisää koodimerkinnät dokumenttiin -komennolla (Add tags to Document). Tämä komento tunnistaa useimmat taulukot oikein, mutta ei ehkä tunnista taulukkoa, josta puuttuvat selvät reunaviivat, otsikot, sarakkeet ja rivit. Käytä lukemisjärjestyksen muutostyökalua, kun haluat selvittää, onko ohjelma tunnistanut taulukon oikein, sekä korjata tunnistusvirheet. Voit lisätä taulukkoihin ja niiden soluihin erikoismuotoiluja käyttämällä Koodimerkinnät-välilehteä (Tags).
	1. Valitse lukemisjärjestyksen muutostyökalu ja napsauta sitten Näytä taulukot ja kuvat –painiketta (Show Tables and Figures). 
	2. Ellei taulukkoa ole selvästi otsikoitu dokumenttiruudussa, valitse koko taulukko vetämällä hiirtä ja napsauta sitten valintaikkunan Taulukko-painiketta (Table).
	3. Napsauta Näytä taulukon solut ja varmista, että taulukon kaikki solut on määritetty erillisiksi elementeiksi (Show Table Cells). 
	4. Jos solut eivät näy erillisinä elementteinä, tee jokin seuraavista toimista:
	 Jos yksi solu tai useita soluja on yhdistetty, valitse lukemisjärjestyksen muutostyökalulla alue yhdestä solusta ja napsauta sitten valintaikkunan Solu-painiketta (Cell). Toista tämä kunkin yhdistetyn solun kohdalla.
	 Jos soluja ei ole korostettu, taulukossa ei ehkä ole käytetty vakiomuotoilua. Luo taulukko uudelleen lähdesovelluksella.
	Jos taulukossa on soluja, joiden pitäisi ulottua kahteen tai useampaan sarakkeeseen, aseta koodimerkintärakenteessa näiden rivien ColSpan- ja RowSpan-määritteet.
	HUOM!
	 Todella työlästä!
	 Vaatii HTML-osaamista.
	5.6 Esteettömien linkkien lisääminen

	1. Valitse teksti tai objekti, jota varten haluat luoda linkin (Käytä Valinta-työkalua / Select).
	2. Napsauta hiiren kakkospainikkeella valintaa ja valitse pikavalikosta Luo linkki (Create Link).
	3. Valitse Luo linkki -valintaikkunasta sopivat asetukset. Määritä sitten URL-osoite, sivunäkymä tai tiedosto linkin kohteeksi näytön ohjeiden mukaan. 
	Linkin kohdalta valittu teksti muuttuu normaalisti linkkitekstiksi. Kun olet lisännyt kaikki linkit, voit muokata koodimerkintäpuuta (Tags) ja lisätä linkkeihin vaihtoehtoiset tekstit PDF-tiedoston esteettömyyden parantamiseksi.
	HUOM! 
	 Vaatii Acrobat Professionalin
	 Acrobat ei osaa tulkita URL-osoitteita, jotka päättyvät kenoviivaan (esim. www.jyu.fi/tutkimus/). Vältä sen käyttämistä.
	5.7 Asetusten tarkastaminen
	5.7.1 Kieli


	PDF-tiedoston kielen määrittäminen mahdollistaa oikean kielen ottamisen käyttöön tietyissä näytönlukuohjelmissa.
	 Koko dokumentin kieli: Tiedosto > Ominaisuudet  > Lisäasetukset-välilehti > Lukuasetukset-ruudun Kieli-valikosta. (Vaihtoehtoina löytyy mm. suomi, ruotsi, englanti, ranska, saksa, espanja, italia, japani, kiina). (File > Document Properties > Advanced > Language).
	 Jos kieli ei löydy valikosta: Kirjoita kielen ISO 639 -koodi Kieli-valikkon ensimmäiselle riville. Lisätietoja ISO-kielikoodeista on osoitteessa http://www.loc.gov/standards.
	 Dokumentin osien tai yksittäisten sanojen kieli: Valitse tekstielementti Koodimerkinnät-välilehdestä > Asetukset > Ominaisuudet > Koodimerkinnät-välilehti > valitse Kieli. (Tags > Options > Properties > Tags > Language).
	5.7.2 Suojaus

	Voit säilyttää dokumentin suojausasetukset ja sallia näytönlukuohjelmien lukevan tekstin käyttämällä jotain seuraavista asetuksista.
	 Vähäinen suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – Vaihda asetukset – ruksaa Salli tekstin, kuvien ja muun sisällön kopioiminen. (Secure – Show security settings… - Password Security – Change Settings – Enable copying of text, images, and other). 
	 Tehokas suojaus: Turvallisuus – Näytä turvallisuusasetukset – Salasanasuojaus – Vaihda asetukset – ruksaa Salli tekstin siirtäminen näytönlukulaitteeseen näkövammaisia varten -vaihtoehto. Tämä asetus ohittaa dokumentin suojausasetukset ja antaa sisällön käyttöoikeudet vain avustavalle ohjelmalle, kuten näytönlukuohjelmalle. Tämä on oletuksena päällä. (Secure – Show security settings… - Password Security – Change Settings – Enable Text Access For Screen Reader Devices For The Visually Impaired).
	5.7.3 Sarkaimen järjestys

	Aseta sarkaimen järjestys seuraamaan dokumentin rakennetta, jotta dokumentin sisältöä voi selata sujuvasti tabulaattorilla.
	1. Avaa Sivut-välilehti (Pages).
	2. Valitse kaikki sivut Ctrl+A (Windows) tai Komento+A (Mac OS).
	3. Valitse välilehdeltä Valinnat – Sivun ominaisuudet (Options – Page Properties).
	4. Valitse Sarkaimen järjestys -välilehti (Tab order) ja ruksaa kohta käytä dokumentin rakennetta (Use document structure).
	6 Esteettömyyden tarkistaminen
	Hyvä tapa testata dokumentin esteettömyys on kokeilla siihen työkaluja, joita lukijat käyttävät. PDF-tiedoston esteettömyyttä voi tarkistaa osin myös Acrobatin sisältämillä menetelmillä, jotka eivät kuitenkaan ole kattavia.
	 tarkistaa dokumentin rakennekoodit, hakukelpoisen tekstin ja esteettömyyteen liittyvät suojausasetukset.
	 Ei kiinnitä huomiota esim. kuvien tai taulukoiden kuvausteksteihin tai järjestykseen.
	 Paina Vaihto+Ctrl+6 (Windows) tai Vaihto+Komento+6 (Mac OS).
	 Selvittää PDF-tiedoston esteettömyysominaisuudet, esimerkiksi kirjasimet, jotka voidaan luotettavasti muuntaa Unicode-tekstiksi ja kuvien/taulukoiden kuvaustekstit.
	 Esittää vihjeitä virheiden korjaamista varten.
	 Täydellinen tarkistus voi kestää kauan, joten kannattaa valita pieni sivualue kerrallaan. Tarkistuksen voi keskeyttää painamalla Esc-näppäintä. 
	1. Lisäasetukset > Käytettävyys > Täydellinen tarkistus (Advanced – Accessibility – Full Check). 
	2. Valitse, miten tulokset näytetään, mikä sivualue tarkistetaan ja mihin esteettömyysongelmiin kiinnitetään huomiota.
	3. Napsauta Aloita tarkistus (Start Checking). 
	 Tarkista lukemisjärjestys nopeasti uudelleenjuoksutusnäkymässä (Näytä – Uudelleenjuoksutus / View – Reflow). 
	 Kokeile Lue ääneen -toimintoa, jotta tiedät, miten tämä tekstiä puheeksi muuntava työkalu toimii: Katso – Lue ääneen (View – Read aloud). HUOM! Toimii vain englanniksi.
	 Tallenna dokumentti tekstinä ja avaa tekstitiedosto tekstinkäsittelyohjelmalla, jotta tiedät, miten pistekirjoitustulostin tulostaa sen.
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